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PictBridge
You can use the USB cable to connect this camera to a printer that supports PictBridge (sold
separately) and print the stored images directly. TIFF, Movie clips and voice files cannot be
printed. You can set up the following settings from the PictBridge menu.

Images : Select the pictures to be printed.

PRINTER SETUP : Setting up printing(Auto Set/Custom Set)

Print : Printing pictures

DPOF Print : Printing the DPOF files

Reset : Initialising the PictBridge functions

Connecting the Camera to a Printer
1. Press the POWER button to turn on the camera.
2. In a mode other than Voice Recording mode, press the

MENU button.
3. Press the LEFT/ RIGHT button and select [Setup] menu

tab.
4. Select [USB] menu by pressing the UP/ DOWN button

and press the RIGHT button.
5. Select [Printer] menu by pressing the UP/ DOWN button

and press the OK button.
6. Press the menu button twice and the menu will disappear.
7. Use the supplied USB cable to connect the camera to the printer as shown below.
8. Turn on the printer to connect the camera to the printer.

If you selected [Computer] in Step 5, when you connect the camera to your printer, the Mode
dial lamp(Green) will illuminate and the connection will not be established. In this case,
disconnect the USB cable, and then follow the procedure from Step 2 and onward.

Back: Set : OK

Setup 
Imprint
Sound Computer
USB Printer
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PictBridge: Picture Selection
Select pictures to print
1. Connect the camera to your printer. The USB menu must

be set to [Printer] before you connect the camera to the
printer. (See p.83)

2. The [Images] menu will appear.
3. Use the UP and DOWN buttons to select the desired

submenu value, and then press the OK button.
When [One Pic] is selected : The PictBridge function will

be applied only to the picture currently displayed.
When [All Pics] is selected : The PictBridge function will be applied to all pictures,

excluding TIFF, movie clips and voice files.

[ When [One Pic] is selected ] [ When [All Pics] is selected ]

- Press the Up/Down button to select the number of prints. 
- Use the Left/Right button to select another picture and select the number of prints for
another picture.

- After setting the number of prints, press the OK button to save.
- Press the Shutter button to return to the menu without setting the number of prints.

0

Exit:Shutter Set:OK

Setting the Number of Copies to Print
- Select [One Pic] or [All Pics]. A screen where you can set the number of copies to print will
appear as shown below.

PREV NEXT

0

Exit:Shutter Set:OK

Move : 

One Pic

All Pics

Images
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PictBridge: Print Setting

Menu

Size Setting the size of the printing paper Auto, Postcard, 4x6, 2L, A4, Letter, A3

Layout Setting the number of pictures to be printed on a sheet of paper Auto, Full, 1, 2, 4, 8, 9, 16

Type Setting the quality of the printing paper Auto, Plain, Photo, Fastphoto

Quality Setting the quality of the picture to be printed Auto, Draft, Normal, Fine

Date Setting whether to print the date Auto, Off, On

File Name Setting whether to print the file name Auto, Off, On

AUTO SET
1. Connect the camera to your printer. The USB menu

must be set to [Printer] before you connect the camera
to the printer. (See p.83)

2. Use the LEFT and RIGHT buttons to select the [Auto
Set] menu tab.

3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[No] : [Custom Set] values are kept.
[Yes] : All values in the [Custom Set] are automatically changed.

Some menu options are not supported in all manufacturer and printer models. If not
supported, the menus are still displayed in the LCD, but are not selectable.
If the setting values are not changed in the automatic/manual setting, the setting values are
automatically kept.

1. Connect the camera to your printer. The [USB] menu
must be set to [Printer] before you connect the camera to
the printer.(See p.83)

2. Use the LEFT and RIGHT buttons to select the [Custom
Set] menu tab.

3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the RIGHT button.

4. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.

CUSTOM SET : You can select the Paper Size, Print Format, Paper Type, Print Quality, Date
Print, and File Name Print menus for printed pictures.

Function Sub menu

The menus you can set up are as follows:

Move : 

No

Yes

Auto Set

Custom Set

Back: Set : OK

Size Auto
LayOut Postcard
Type 4X6
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PictBridge: Printing
Printing Pictures
1. Connect the camera to your printer. The USB menu

must be set to [Printer] before you connect the camera
to the printer. (See p.83)

2. Use the LEFT and RIGHT buttons to select the [Print]
menu tab.

3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[Standard] : Print the pictures stored in the memory

card in set numbers. One picture is printed on one piece of paper.
[Index] : Print multiple images on one sheet of paper.

1. Connect the camera to your printer. The [USB] menu
must be set to [Printer] before you connect the camera
to the printer. (See p.83)

2. Use the LEFT and RIGHT buttons to select the [DPOF
Print] menu tab.

3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[No] : Cancel the printing
[Yes] : Directly print the file with the DPOF information
Depending on the manufacturer and printer model, some menus may not be available.
With a printer without supporting the DPOF, the menu is still displayed but not available.

4. The screen shown on the right will appear and the
picture will be printed. If no picture is selected, the [No
Image !] message will be displayed. Press the Menu/OK
button while printing to cancel the printing and the [Print]
menu is displayed.
Number of pictures in a index print varies depends on
the printer used.

DPOF PRINT : This allows you to directly print the files with DPOF information.

Print

Move:

Standard

Index

Now Printing

1/1

Cancel : OK

DPOF Print

Move:

No

Yes
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PictBridge : RESET
Initialises user-changed configurations.
1. Connect the camera to your printer. The [USB] menu

must be set to [Printer] before you connect the camera
to the printer. (See p.83)

2. Use the LEFT and RIGHT buttons to select the [Reset]
menu tab.

3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
- If [No] is selected : Settings will not be reset.
- If [Yes] is selected : All print and image settings will be reset.

Default print setting varies depending on the printer manufacturer.
For your printer’s default setting, refer to the user’s guide that came with your printer.

Reset

Move:

No

Yes



88

Setup menu
In this mode, you can set up basic settings. 
You can use the setup menu in all camera modes, except Voice Recording mode.         
The items indicated by                are default settings.

Menu tab Main menu Sub menu Secondary menu Page

Reset -

Series -

Power Off Off, 1, 3, 5, 10 min - p.90

ENGLISH 한국어 FRANÇAI

DEUTSCH ESPAÑOL ITALIAN

日本語

P”CCK»… PORTUGUÊS DUTCH p.87

DANSK SVENSKA SUOMI

BAHASA

POLSKI Magyar -

No -

Yes -

05/01/01 13:00 -

yy/mm/dd -

dd/mm/yy -

mm/dd/yy -

Off -

Imprint Date - p.92

D & Time -

Off -

Low -

Medium -

High -

File

Format

D&Time

Sound

p.89

p.91

p.91

p.92

p.93

Language
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Setup menu

This function allows the user to select the file naming format.

Assigning File Names
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [File] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Reset] : After using the reset function, the next file name will be set from 0001 even

after formatting, deleting all or inserting a new memory card.
[Series] : New files are named using numbers that follow the previous sequence, even

when a new memory card is used, or after formatting, or after deleting all
pictures

5. Press the menu button twice and the menu will disappear.

File name

* Menus are subject to change without prior notice.

Back: Set : OK

File Reset
Power Off Series
Language

3072

Setup

Menu tab Main menu Sub menu Secondary menu Page

Computer -

Printer -

Off -

On -

Dark -

LCD Normal - p.94

Bright -

NTSC -

PAL -

Quick View Off/ 0.5, 1, 3sec - p.96

No -

Yes -

USB

Video Out

AF Lamp

Reset

p.93

p.94

p.95

p.96
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File name

The first stored folder name is 100SSCAM, and the first file name is SV200001.
File names are assigned sequentially from SV200001 SV200002 ~ SV209999.
The folder number is assigned sequentially from 100 to 999 as follows
: 100SSCAM 101SSCAM ~ 999SSCAM.
The files used with the memory card conform to the DCF(Design rule for Camera File
systems) format.

INFORMATION

Even if the batteries or AC adapter are removed and inserted again, the power off setting
will be preserved.
Note that the automatic power off function will not operate if the camera is in PC mode, slide
show, playing back a voice recording, playing back a movie clip or during composite shooting.

INFORMATION

Auto power off

Setting Power Off
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Power Off] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Off] : The power off function will not operate.
[1, 3, 5, 10min] : The power will turn off automatically if not used for the period of time

specified.
5. Press the menu button twice and the menu will disappear.

This function switches the camera off after a set amount of time in order to prevent
unnecessary battery drainage.

Back: Set : OK

File Off
Power Off 1 min
Language 3 min

3072

Setup
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Language 

Setting Language
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Language] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button. 
LANGUAGE sub menu : English, Korean, French, German, Spanish, Italian, S. Chinese,
T. Chinese, Japanese, Russian, Portuguese, Dutch, Danish, Swedish, Finnish, Thai,
BAHASA(MALAY/ INDONESIAN) and Arabic. 

5. Press the menu button twice and the menu will disappear.

Formatting a Memory Card
1. In any mode other than Voice Recording mode, press the

MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Format] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [No] is selected : The memory card will not be formatted. 

Press the menu button twice and the menu display will disappear. 
If [Yes] is selected : A [Please Wait !] message appears and the memory card will be

formatted. If you ran FORMAT in Play mode, a [No Image !]
message will appear.

There is a choice of languages that can be displayed on the LCD monitor. Even if the batteries or
AC adapter are removed and inserted again, the language setting will be preserved.

Formatting a memory card

This is used for formatting the memory card. If you run [Format] on the memory card, all
images, including the protected images, will be deleted. Be sure to download important
images to your PC before formatting the memory card.

Be sure to run [Format] on the following types of memory card.
- A new memory card, or an unformatted memory card.
- A memory card that has a file this camera can t recognise or one that has been taken
from another camera.

Always format the memory card using this camera. If you insert a memory card that has
been formatted using other cameras, memory card readers, or PCs, you will get a [Card
Error!] message.

INFORMATION

Back: Set : OK

File English
Power Off
Language Français

3072

Setup

Back: Set : OK

Power Off
Language No
Format Yes

3072

Setup
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Setting up the Date/ Time/ Date type
You can change the date and time that will be displayed on the captured images and set up
the date type.

Setting Date/Time & Selecting Date Format
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [D & Time] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP, DOWN, LEFT, and RIGHT buttons to select

the desired submenu value, and then press the OK button.
RIGHT button : Selects the year/month / day/hour / minute date type.
LEFT button : Moves the cursor to the [D & Time] main menu if the cursor is at the first item

of the date and time setup. In all other cases, the cursor will be shifted to the
left of its current position.

UP and DOWN buttons : Changes the setting value.
- Date type : [yy/mm/dd] /[dd/mm/yy] /[mm/dd/yy]

5. Press the menu button twice and the menu will disappear.

There is an option to include DATE/TIME on still images.
Date Imprinting
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Imprint] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP and DOWN buttons to select the desired date

imprint type, and then press the OK button.
[Off] : The DATE & TIME will not be imprinted on the image file.
[Date] : Only the DATE will be imprinted on the image file.
[D & Time] : The DATE & TIME will be imprinted on the image file.

5. Press the menu button twice and the menu will disappear.

* The Date & Time are imprinted at the bottom right side of the still image.
* The date will be imprinted as a DATE TYPE setting.
* TIME is imprinted in the following way : [Hour : Minute] and hours are shown using the 24

hour clock.
* The imprint function is applied only to still images except for the images taken in the [Text]

scene mode. 

Imprinting the recording date

Back: Set : OK

Format Off
D & Time Date
lmprint D & Time

3072

Setup

Back: Set : OK

Language
Format
D & Time

3072

Setup

05 / 01/ 01 01:00

yy/mm/dd
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Sound 

Connecting an External Device (USB)

If you set the operation sound to ON, various sounds will be activated for camera startup,
when button are pressed, and if there is a card error, so that you can be aware of the camera
operation status.

Setting Operation Sounds
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Sound] sub menu : Off/ Low/ Medium/ High

5. Press the menu button twice and the menu will disappear.

You can select an external device to which you want to connect the camera using the USB
cable.

Selecting an External Device
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [USB] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Computer] : Select this if you want to connect the camera to your PC. 

Refer to page 120 for instructions on how to connect the camera to your
PC.

[Printer] : Select this if you want to connect the camera to your printer. 
Refer to page 83 for instructions on how to connect the camera to your
printer.

5. Press the menu button twice and the menu will disappear.

Back: Set : OK

D & Time Off
lmprint Low
Sound Medium

3072

Setup

Back: Set : OK

lmprint
Sound Computer
USB Printer

3072

Setup
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Auto Focus lamp

LCD brightness

You can adjust the LCD brightness.

Adjusting LCD Brightness
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [LCD] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[LCD] sub menu : Dark, Normal, Bright

5. Press the menu button twice and the menu will disappear.

You can turn on and off the Auto Focus lamp

How to set up the lamp
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [AF Lamp] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [Off] is selected : The AF lamp will not light up.
If [On] is selected : The AF lamp will light up.

If you select [Off] menu and take an image in poorly lit condition or select the [Night]
scene mode, the camera may not take exact focus.

Back: Set : OK

Sound
USB Off
AF Lamp On

3072

Setup

Back: Set : OK

USB Dark
AF Lamp Normal
LCD Bright

3072

Setup
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Selecting Video out type
The Video output signal from the camera can be NTSC or PAL. 
Your choice of output will be governed by the type of device (monitor or TV, etc.) to which the
camera is connected. PAL mode can support only BDGHI.

Setting the Video Out Type
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Video Out] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Video Out] sub menu : NTSC, PAL

5. Press the menu button twice and the menu will disappear.

NTSC : U.S.A, Canada, Japan, South Korea, Taiwan, Mexico.
PAL : Australia, Austria, Belgium, China, Denmark, Finland, Germany, U.K., Holland,

Italy, Kuwait, Malaysia, New Zealand, Singapore, Spain, Sweden, Switzerland,
Thailand, Norway.

When using a TV as an external monitor, you will need to select the external or AV
channel of the TV.
There will be a digital noise on the external monitor, but it is not a malfunction.
If the image is not in the centre of the screen, use the TV controls to centre it.
When the camera is connected to an external monitor, the menu will be visible on the
external monitor and the menu functions are the same as those indicated on the LCD
monitor.

INFORMATION

Connecting to an external monitor
In RECORDING/ PLAY mode, you can
view the stored still images or movie clips
by connecting the camera to an external
monitor via the AV cable. When the
camera is connected to an external
monitor, the LCD monitor will be turned
off automatically.

Yellow Colour-Video
White Colour-Voice

Back: Set : OK

AF Lamp
LCD NTSC
Video Out PAL

3072

Setup
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Quick view
If you enable Quick View before capturing an image, you can view the image you just
captured on the LCD monitor for the duration set in the [Quick View] setup. Quick view is
possible only with still images.

Setting Quick View
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Quick View] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[off] : The quick view function can’t be activated.
[0.5, 1, 3sec] : The captured image is briefly displayed during the selected time.

5. Press the menu button twice and the menu will disappear.

Initialisation

All camera menu and function settings will be restored to their default values. 
However, values for DATE/ TIME, LANGUAGE, and VIDEO OUT will not be changed.

Initialising the Camera
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Reset] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [No] is selected : Settings will not be restored to their defaults.
If [Yes] is selected : All settings will be restored to their defaults.

Back: Set : OK

LCD Off
Video Out 0.5 sec
Quick View 1 sec

3072

Setup

Back: Set : OK

Video Out
Quick View No
Reset Yes

3072

Setup
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Setting up the MYCAM menu
You can set up a start up image, start up sound and shutter sound. Every camera working
mode (with the exception of Voice recording mode) has the MyCAM menu.
The items indicated by                        are default settings.

Menu tab Main menu Sub menu Page

Off LOGO

User Image 1 User Image 2

Off Sound 1

Sound 2 Sound 3

Off Sound 1

Sound 2 Sound 3

S.Image

S.Sound

SH.Sound

p.97

p.98

p.98

You can select the image that is first displayed on the LCD monitor whenever the camera is
turned on.

Setting a Startup Image
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [S.Image] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Start up image

Use a saved image for the start-up image with the [User Image] in the [Resize] menu in
the play mode.
The start-up image will not be deleted by deleting all images or [Format] menu.
The User images will be deleted by [Reset] menu.

INFORMATION

* Menus are subject to change without prior notice.

Back: Set : OK

S.Image
S.Sound
SH.Sound

3072

Mycam



98

Start up sound

You can select the shutter sound.

Selecting the Shutter Sound
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [SH.Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Shutter sound

Setting the Startup Sound
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [S.Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Back: Set : OK

3072

Mycam
S.Image Off
S.Sound Sound1
SH.Sound Sound2

Back: Set : OK

3072

Mycam
S.Image Off
S.Sound Sound1
SH.Sound Sound2

You can select the sound that is activated whenever the camera is turned on.
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Important notes
Be sure to observe the following precautions!

This unit contains precision electronic components. Do not use or store this unit in the
following locations.
- Areas exposed to severe changes in temperature and humidity.
- Areas exposed to dust and dirt.
- Areas exposed to direct sunlight or the inside of a vehicle in hot weather.
- Environments where there is high magnetism or excessive vibration.
- Areas with high explosives or highly flammable materials.

Do not let the unit come into contact with dust, vinyl goods, or chemicals, such as
insecticides, for an extended period of time.

Sand can be particularly troublesome to cameras.
- Do not let sand get inside the unit when using it on beaches, coastal dunes, or other areas
where there is lots of sand.

- Doing so may result in failure or may permanently render the unit unusable.

Handling the camera
- Never drop the camera or subject it to severe shocks or vibrations.
- This camera is not waterproof. To avoid dangerous electrical shocks, never hold or operate
the camera with wet hands.

- If you use this camera in wet places, such as beach or pool, do not let water or sand get
inside the camera.

Extremes in temperature may cause problems.
- If the camera is transferred from a cold to a warm and humid environment, condensation
can form on the delicate electronic circuitry. If this occurs, turn the camera off and wait for at
least 1 hour until all moisture is dispersed. Moisture build up can also occur in the memory
card. If this happens, turn off the camera and remove the memory card. Wait until the
moisture has dispersed.
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Important notes
Caution on Using the Lens
- If the lens is subjected to direct sunlight, it could result in discoloration and deterioration of
the image sensor.

- Pay attention not to get fingerprints or foreign substances on the surface of the lens.

If the digital camera is not used for a long period, an electric discharge can occur. 
It is a good idea to remove the batteries and the memory card if you do not intend using the
camera for an extended period of time.

If the camera is exposed to an electronic interference, it will turn itself off to protect the
memory card.

Camera Maintenance
- Use a soft brush (available from photo stores) to gently clean the lens and LCD assemblies.
If this does not work, lens-cleaning paper with lens cleaning fluid can be used.
Clean the camera body with a soft cloth. Do not allow this camera to come into contact with
solvent materials such as benzol, insecticide, thinners etc. This may damage the body shell
of the camera and also affect its performance. Rough handling can damage the LCD
monitor. Take care to avoid damage and keep the camera in its protective carry case at all
times when not in use.

Do not attempt to disassemble or modify the camera.

Under certain conditions, static electricity can cause the flash unit to fire. This is not harmful to
the camera and is not a malfunction.

When images are uploaded or downloaded, the data transfer may be affected by static
electricity. In this case, disconnect and re-connect the USB cable before trying the transfer
again.

Before an important event or going on a trip, you should check the camera condition. 
- Take a picture for testing the camera condition and prepare extra batteries.
- Samsung cannot be held responsible for camera malfunctions. 
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Warning indicator
There are several warnings that may appear on the LCD display.

Card Error !
Memory card error

Turn off the camera power and turn it on again
Insert the memory card again
Insert the memory card and format the memory card (p.91)

No Card !
A memory card is not inserted

Insert a memory card
The camera can t recognise the memory card

Insert the memory card again
Turn off the camera power and turn it on again

Card Locked !
The memory card is locked

SD memory card : Slide the write protect switch to the top of the memory card

Card Full !
There is insufficient memory capacity to take an image

Insert a new memory card
Delete unnecessary image files to free up some memory

No Image !
There are no images stored on the memory card

Take images
Insert a memory card that is holding some images

File Error !
File error

Format the memory card
Memory card error

Contact a camera service centre

Low Battery !
There is low battery capacity

Insert charged battery
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Warning indicator

Please check the following

Before contacting a service centre

Low Light !
When taking pictures in dark places

Use a tripod and take pictures in Flash Photography mode

Set USB
[USB] sub menu and connected device are not matched.

Reconfigure [USB] in the [Setup] menu. 

Out Of Number
When selecting too many printing pages in the PictBridge menu. 

Select printing page within the limitation. 

The camera doesn’t switch on
There is low battery capacity.

Insert charged battery. 
Batteries are inserted incorrectly with the reverse polarities.

Insert the batteries according to the polarity marks (+, -).

The camera power ceases while in use.
The batteries are exhausted.

Insert charged battery.
The Camera is turned off automatically.

Turn off the camera power and turn it on again.

Batteries drain quickly
The Camera is being used in low temperatures.

Keep the camera in warm conditions (i.e. inside a coat or jacket) and only remove it in
order to take images.
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Before contacting a service centre
Camera does not take images when pressing the Shutter button

There is insufficient memory capacity.
Delete unnecessary image files

The memory card has not been formatted
Format the memory card (p.91)

The memory card is exhausted
Insert a new memory card

The memory card is locked
Refer to [Card Locked !] error message (p.101)

The camera’s power is off
Turn the camera power on

The batteries are exhausted
Insert charged battery. 

Batteries are inserted incorrectly with the reverse polarities.
Insert the batteries according to the polarity marks (+, -).

The camera suddenly stops working while in use 
The camera was stopped due to a malfunction

Remove /re-insert batteries and switch the camera on

The images are unclear
A picture was taken within 0.8 m from the subject without setting an appropriate macro mode

If the subject is closer than 0.8m, select macro shot mode
Taking a picture beyond the flash range

Take a picture within the flash range
The lens is smudged or dirty

Clean the lens

The flash does not fire
Flash off mode has been selected

Dis-engage flash off mode
The camera mode can’t use the flash

Refer to the FLASH instruction (p.34)

Incorrect date and time is displayed
The date and time have been set incorrectly or the camera has adopted the default settings

Reset the date and time correctly
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Before contacting a service centre
The images don't play back

Incorrect file name (Violation of DCF format)
Do not change the image file name

Colour of image is different to the original scene 
White balance setting is incorrect

Select appropriate White balance

Images are too bright
Exposure is excessive

Reset exposure compensation

No image on external monitor
The external monitor has not been connected properly with the camera

Check the connection cables
There are incorrect files in the memory card

Insert a memory card that has correct files

When using the PC’s explorer, the [Removable Disk] file does not show
Cable connection is incorrect

Check the connection
The camera is off

Turn the camera on
The operating system is not Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3.
Alternatively the PC does not support USB

Install Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3 to PC that supports USB
The camera driver is not installed

Install a [USB Storage Driver]
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Specifications
Type 1/1.8" CCD
Effective Pixel Approx. 8.1 Mega-pixel
Total Pixel Approx. 8.4 Mega-pixel

Schneider Lens f = 7.8 ~ 23.4 mm  
(35mm film equivalent : 38 ~ 114 mm)

F No. F2.8 ~ F5.1
Still Image mode : 1.0X ~ 10.0X 
Play mode : 1.0X ~ 12.75X (depends on image size)

Viewfinder LCD Monitor 2.5" Colour TFT LCD (118,080 dots)
Type TTL auto focus, Manual focus

Normal : 80cm ~ infinity
Macro : 4 ~ 80cm (Wide), 25 ~ 80cm (Tele)
Auto Macro : 4cm ~ infinity (Wide), 25 ~ infinity (Tele)

Type Mechanical and Electronic shutter
Shutter Auto : 1 ~ 1/2,000 sec. Manual : 15 ~ 1/2,000 sec. 

Night : 8 ~ 1/2,000 sec.
Program AE, Shutter Priority AE, Aperture Priority AE or

Control Manual Exposure
Metering : Multi, Spot

Compensation 2.0EV (1/3EV steps)
ISO Equivalent Auto, 50, 100, 200, 400 

Auto, Auto & Red-eye reduction, 
Slow sync, Fill-in, Off

Range Wide : 0.2 ~ 3.0m,  Tele : 0.25 ~ 2.0m
Recharging Time Approx. 7 sec.

Sharpness Soft, Normal, Vivid
Effect Normal, B&W, Sepia, Negative. Red, Green, Blue, RGB

Auto, Daylight, Cloudy, Fluorescent_H, Fluorescent_L,
Tungsten, Custom1, Custom 2
Voice Recording (max. 1 hour)
Voice Memo in Still Image (max. 10 sec.)

Date Imprinting Date&Time, Date, Off (user selectable)
Modes : Auto, Program, A, S, M, MySET, Scene
* Scene : Night, Portrait, Children, Landscape, Close-up, 

Text, Sunset, Dawn, Backlight, Fireworks,
Beach/Snow        

Shooting : Single, Continuous, AEB, AFB
Self-timer : 2 sec., 10 sec., Double, Remote control
With audio (recording time : memory capacity dependent)
Size : 640x480, 320x240, 160x128 
Frame rate : 30 fps, 15 fps

Image Sensor

Lens

Focal Length

Range

Speed

Modes

Digital Zoom

Focusing

Exposure

Flash

Shooting

Voice Recording

White Balance

Movie Clip

Still Image
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Specifications
Internal : About 20MB
SD : up to 1GB guaranteed (MMC Compatible) 
Still Image : JPEG (DCF), EXIF 2.2, DPOF 1.1, PictBridge 1.0
Movie Clip : AVI (MPEG-4) Audio : WAV
3072 : 3072x2304pixels,   2816 : 2816x2112pixels,
2592 : 2592x1944pixels,   2272 : 2272x1704pixels,
2048 : 2048x1536pixels,   1600 : 1600x1200pixels,
1024 : 1024x768pixels,    640 : 640x480pixels      
3264 : Super fine 9 Fine 15 Normal 23 TIFF 1
3072 : Super fine 9 Fine 15 Normal 23 TIFF 1
2816 : Super fine 10 Fine 18 Normal 26 TIFF 1
2592 : Super fine 11 Fine 21 Normal 33 TIFF 1
2272 : Super fine 14 Fine 26 Normal 40 TIFF 2
2048 : Super fine 17 Fine 33 Normal 50 TIFF 3
1600 : Super fine 30 Fine 51 Normal 60 TIFF 4
1024 : Super fine 60 Fine 106 Normal 129 TIFF 11
640  : Super fine 121 Fine 165 Normal 202 TIFF 22
* These figures are measured under Samsung’s standard

conditions and may vary depending on shooting conditions
and camera settings.

Type Single image, Thumbnails, Slide show, Album organisation, Movie clip
Editing Trimming, Resizing, Rotating

Digital output connector : USB 2.0
Audio : Mono 
Video output : NTSC, PAL (user selectable)
DC power input connector : 3.3V
Rechargeable battery : Li-ion SLB-1137 

(3.7V, 1,130mAh)
AC Adapter : SAC - 32(DC 3.3V, 2.0A)

Dimensions (W x H x D) 106 x 56.4 x 30.5  mm(excluding the projecting parts of the camera)
Weight Approx. 150g (without batteries and card)
Operating Temperature 0 ~ 40˚C
Operating Humidity 5 ~ 85%

Camera Driver Storage Driver (Windows98/98SE/2000/ME/XP, Mac OS 9.2 ~ 10.3)
Application Digimax Master, Digimax Reader

MPEG-4 VGA 30fps Movie Clip
Text recognition(Digimax Reader included) 
A World Superior Schneider Lens 

* Specifications are subject to change without prior notice.
* All trademarks are the property of their respective owners.

Capacity 
(32MB)

Image Size

Storage

Image Play

Power Source

Special Features

Software

Interface

Media

File Format
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Software Notes
Please ensure that you read the instruction manual carefully before use.

The attached software is a camera driver and image editing software tool for Windows.
Under no circumstances should all or part of either the software or the user manual be
reproduced.
Copyrights for software are licensed only for use with a camera.
In the unlikely event of a manufacturing fault, we will repair or exchange your camera. 
We cannot, however, be held responsible in any way for damage caused by inappropriate
use.
Using a Hand-made PC or a PC and OS that has not been guaranteed by the manufacturer is
not covered by the Samsung warranty.
Before reading this manual, you should have a basic knowledge of computers and O/S
(Operating Systems).

For Windows For Macintosh

Power Mac G3 or later

Windows 98/98SE/2000/ME/XP Mac OS 9.2 ~ 10.3

Minimum 64MB RAM (XP : 128MB) Minimum 64MB RAM

200MB of available hard disk space 110MB of available hard-disk space

(1GB recommended)

USB port USB port

CD-ROM drive CD-ROM drive

QuickTime player

DivX(for movie clip)

PC with processor better than Pentium II 450Mz

(Pentium 700MHz recommended)

1024x768 pixels, 16-bit colour display

compatible monitor (24-bit color display

recommended)

System Requirements
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About the software
After inserting the software CD provided with this camera into the CD-ROM drive, the following
window should automatically run.

Before connecting the camera to the PC,
you should first install the camera driver.

Camera driver : This enables images to transfer between the camera and PC.
This camera uses the USB Storage Driver as the camera driver. You can use the camera as
a USB card reader. After installing the driver and connecting this camera to the PC, you can
find [Removable Disk] in [Windows Explorer] or [My computer]. A USB Storage Driver is
provided only for Windows. A USB Driver for MAC is not included with the Application CD.
But you can use the camera with Mac OS 9.2 ~ 10.3.

XviD codec : This makes movie clips(MPEG-4) recorded with this camera play back on a PC.
To play back a movie clip recorded with this camera, you must install the XviD codec. If a
movie clip recorded with this camera does not play well, install this codec. This software is
only compatible with Windows.
If a movie clip can’t play back on the Mac OS, please visit the following site.
http://www.divx.com/divx/mac/ 
If a movie clip can’t play back on the Mac OS, use a media player that supports XviD codec
(Mplayer, VLC(VideoLan Client) media player).

Digimax Viewer : This is a program for viewing stored images.
You can see the stored images in the memory directly on a PC monitor. You can also copy,
move or delete the images and enlarge/downscale the image sizes with Digimax Viewer.
This software is only compatible with Windows.
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About the software

Be sure to check the system requirements before installing the driver.
You should allow 5~10 seconds for running the automatic setup program according to the
capability of the computer. If the frame does not show, run the [Windows Explorer] and
select [Samsung.exe] in the CD-ROM Drive root directory.

INFORMATION

Digimax Reader : Text recognition program
You can save an image file that was captured in the TEXT mode as a text file with this
program. This software is only compatible with Windows.

PhotoImpression : Image editing program.
You can edit or store still images that you download from the camera. This software is only
compatible with Windows.
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Setting up the application software
To use this camera with a PC, install the application software first.
After this has been done, the stored images in the camera can be moved to the PC and can be
edited by an image editing program.

You can visit the Samsung web-site through the internet.

http://www.samsungcamera.com : English
http://www.samsungcamera.co.kr : Korean

1. Click the [Install] menu in the Autorun frame.
The camera driver is installed automatically.

Close other programs before installing the application software.
Before installing the application software, disconnect the USB connection.

INFORMATION

2. Installation is complete.
Click the [Finish] button.

[Click !]

[Click !]

3. The Software License Agreement window for
DirectX will be displayed.
If you agree to this, select [I accept the agreement]
and click [Next >] button. the window will then
move to the next step. If you disagree, select 
[I do not accept the agreement] and click [Cancel]
button.
The installation program will be cancelled.

[Click !]
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Setting up the application software

6. A windows to check whether the PC has XviD codec or not
will display.  
[Preview] : You can check the movie clip display

condition. 
[Install] : The XviD codec is installed. 
[Cancel] : The XviD codec is not installed and a window for

installing the application softwares will display.

If you didn’t click the [Preview] button, the [Install] button can’t be selected. 

[Click !]

4. A window will open. Click the [Next(N) >] button.

5. DirectX Installation is completed.
Click the [Finish] button and Digimax Master
installation will be started.
* The system will not reboot even if you click

the [Finish] button.
* The screen shot of step 5 can be different

with the illustration according to the system
requirements.

[Click !]

[Click !]
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9. The Software License Agreement window will be
displayed. If you agree to this, select [I accept the
agreement] and click [Next>] button. the window will
then move to the next step. If you disagree, select [I do
not accept the agreement] and click [Cancel] button.
The installation program will be cancelled.

The XviD codec is distributed according to the GNU General Public License and everyone
can copy, distribute and change this codec. For more information, see the License
documents. 

[Click !]

7. If an error listed below takes place during the preview,
click the [Install] button to install the XviD codec. 

- Only a voice plays back. 
- An error message displays and the movie clip does
not play back. 

* A window shown alongside may display according
to the system requirements.

8. The XviD codec installation window will be displayed
as shown alongside. Click the [Next(N)>] button. 

Setting up the application software

[Click !]

[Click !]
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Setting up the application software
10. The XviD information window will display. 

Click the [Next>] button. 

11. The destination selection window will open. 
Click [Next >] button.
To copy to the files to another folder, click [Browse...]
and choose a folder you want.

[Click !]

[Click !]

13. The [Select Additional Tasks] window will display. 
Select the additional tasks and click the [Next>] button. 

12. A window will open, asking you to choose a folder to
which program icons will be added. 
Click [Next >] button. 
If you want to add the program icons to a different folder,
choose another folder, and then click [Next >] button.

[Click !]

[Click !]
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Setting up the application software
14. The XviD codec is ready to install. 

Click the [Install] button.

[Click !]

15. Installation is complete.
Click the [Finish] button.

[Click !]

If you select [Exit] at step 13, the application program installation will be cancelled.

INFORMATION 

16. A window where you can choose the program
you want to install will appear. Click [Install].
For information on application software, please
refer to page 108.

[Click !]

7. The Digimax Master installation window will be
displayed as shown alongside. Click the [Next >]
button.

[Click !]
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Setting up the application software

8. A window will open. Click the [Next >] button.

9. A destination selection window will open. Click [Next >].
To copy to the files to another folder, click [Browse..]
and choose a folder you want.

11. Click [Install(I)] button and Digimax Master starts installing.

10. A window will open, asking you to choose a folder to
which program icons will be added. Click [Next >] button.
If you want to choose another folder, click [Browse..] and
choose a folder you want.

● If you select [Cancel] at step 7, a window for installing Digimax Reader will be displayed.

INFORMATION

[Click !]

[Click !]

[Click !]

[Click !]
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Setting up the application software

13. A window will be displayed as shown alongside.
Click the [INSTALL] button.
- Check the [MANUAL] button. Instructions for using
Digimax reader will be displayed.

- Click the [EXIT] button and Digimax reader
installation will be cancelled and a window for
restarting the computer.

14. A window will open. Click the [Next >] button.

[Click !]

15. The Software License Agreement window will be
displayed. If you agree to this, click [Yes],
the window will then move to the next step.
If you disagree, click [No] and the installation
program will be cancelled.

12. Digimax Master installation is successfully completed.
Click the [Finish] button to install Digimax Reader.
* The screen shot of step 12 can be different with the

illustration according to the system requirements.

[Click !]

[Click !]

[Click !]



122

Setting up the application software
16. A destination selection window will open.

Click the [Next >] button.
To copy to the files to another folder, click
[Browse...] and choose a folder you want.

[Click !]

17. Digimax Reader Installation is completed.
The system will not reboot even if the [Yes, I
want to restart the computer now] option is
selected.

※ The screen shot of step 17 can be different 
with the illustration according to the system
requirements.

18. To apply changes, you must restart the computer.
Select [Yes, I want to restart my computer now], and
then click the [OK] button. 

19. After restarting the computer, connect the PC to the camera with the USB cable.

20. Turn the camera power on.
[Found New Hardware Wizard] will open and 
the computer will recognise the camera.
* If your OS is Windows XP, an image viewer

program will open.
If the download window of Digimax Master opens,
the camera driver was setup successfully.

[Click !]

[Click !]
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Setting up the application software

● If you have installed the camera driver, [Found New Hardware Wizard] may not open.
● On a Windows 98 or 98 SE system, the Found New Hardware Wizard dialog box opens

and a window asking you to select a driver file may appear. In this case, specify "USB
Driver" in the CD supplied. (for Windows 98 and 98 SE).

● Before connecting the camera to the PC, You should first install the camera driver.
● After installing the camera driver, you have to restart your PC.
● If you connect the camera to the PC before installing the camera driver, the [Found New

Hardware Wizard] will open.
In this case, cancel the [Found New Hardware Wizard] and disconnect the camera.
Install the camera driver and connect the camera to the PC again.

● Should the computer not find the camera driver after installation, please try one or more of
the following measures.
1. Delete the camera driver (p.123), and re-install the driver.
2. Refer to FAQ (p.132) to check for a possible solution to the problem.
3. If your PC’s central processing unit is VIA chip (This is shown in the USB Host

Controller), download the patch file from the Samsung Camera web page.
(http://www.samsungcamera.com)

INFORMATION

21. If you can see [Removable Disk] under [My computer],
the camera driver installation was successful.
Now you can transfer image files from the camera to
PC via the USB cable.
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Starting PC mode
If you connect the USB cable to a USB port on your PC and then turn on the power, the
camera will automatically switch to "computer connection mode".
In this mode, you can download stored images to your PC through the USB cable.
The LCD monitor is always turned off in PC mode.
The auto focus lamp will blinks when the files are transferring via the USB connection.

Connecting the camera to a PC
1. Turn the PC power on.
2. Turn the camera power on.
3. In any mode other than Voice Recording mode, press

the MENU button.
4. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
5. Select the [USB] menu by pressing the UP/ DOWN

button and press the RIGHT button.
6. Use the UP and DOWN buttons to select [Computer],

and then press the OK button.
7. Press the menu button twice and the menu will disappear.
8. Connect the PC and the camera via the USB cable.

- Insert the small plug of the USB cable into the camera USB connection terminal.
- Insert the large connector of the USB cable into the USB port of the PC.
- The plugs must be firmly inserted.

The camera driver must be installed before using PC mode.
To save battery power, it is recommended that you use an AC adapter (Optional) when
connecting the camera to a computer.

INFORMATION

Disconnecting the camera and PC : Refer to page 125 (Removing the removable disk).

If you selected [Printer] in Step 6, when you
connect the camera to your computer, the
[Connecting Printer] message will be
displayed on the LCD monitor and the
connection will not be established. In this
case, disconnect the USB cable, and then
follow the procedure from Step 3 and
onward.

Back: Set : OK

Setup 
Imprint
Sound Computer
USB Printer



125

Starting PC mode

3. Select an image and press the right mouse
button.

4. A pop-up menu will open.
Click [Cut] or [Copy] menu.
- [Cut] : cuts a selected file.
- [Copy] : copies files.

Downloading stored images
You can download the still images stored on the camera to your PC's hard disk and print
them or use a photo editing software to edit them.

1. Connect the camera to your PC with the USB cable.

2. On your computer's desktop display, select
[My computer] and double click [Removable Disk

DCIM 100SSCAM].
The image files will then be displayed.

5. Click a folder where you want to paste the file.
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Starting PC Mode
6. Press the right mouse button and a pop-up menu

will open. Click [Paste].

7. An image file is transferred from the camera to
your PC.

- By using [Digimax Viewer], you can see the stored images in the memory directly on the PC
monitor and you can copy or move the image files.
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Removing the USB Driver for Windows 98SE
■ To remove the USB driver, refer to the process shown below.

1. Trace [Start → Settings] and click [Control Panel].

4. Click the [OK] button.
The camera is removed from the system.

2. Double-click [System].

3. Select [Device manager → Hard Disk Controller →
Samsung Digital Camera] and click the [Delete]
button.

[Click !]
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5. Trace [Start → Settings → Control Panel] and
double click [Add/Remove programs].

6. The [Add/Remove Programs Properties] window
will open. Click [Digimax V800] and click the
[Add/Remove] button.

7. Uninstallation is complete. Click the [Finish] button
and the window will disappear.

[Click !]

[Click !]
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Removable Disk
To use this camera as a Removable Disk, install (p.110) the USB Driver.

1. Before turning the camera power on, connect the camera to the PC with the USB cable.

2. Click [Removable Disk] under [My computer] or [Windows Explorer].

3. Image files stored in the Removable Disk (DCIM 100SSCAM) can be transferred to the
PC.

Important information whilst using the Removable Disk
The [Removable Disk] indicator will not show when the camera power is off or the USB
cable is removed.
We recommend that you should copy the images to the PC to view them. Opening
images directly from the removable disk may be subject to unexpected disconnection.
When uploading images from the PC to the camera, ensure that the uploaded file names
are not the same as those already stored on the memory. 
When you upload a file that is not taken by this camera to Removable Disk, the [File
Error!] message will be displayed on the LCD monitor in the PLAY mode, and nothing is
displayed in THUMBNAIL mode.
The auto focus lamp will blink, when a file is
transferred (copy or deletion) between the PC
and the camera. Do not remove the USB cable
until the lamp stops blinking. To remove the
USB cable in Windows 2000/ME/XP, use the
[Unplug or Eject Hardware] icon on the task bar.

INFORMATION
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Removing the removable disk
Windows 98/98SE
1. Check whether the camera and PC are transferring a file. If the auto focus lamp blinks, you

have to wait until the lamp is turned off.
2. Unplug the USB cable.

Windows 2000/ME/XP
(The illustrations may be different from the real display in accordance with the Windows O/S.)
1. Check whether the camera and PC are transferring a file. If the auto focus lamp blinks, you

have to wait until the lamp is turned off.

2. Double-click the [Unplug or Eject Hardware]
icon on the task bar.

3. The [Unplug or Eject Hardware] window will
open. Select the [USB Mass Storage
Device] and click the [Stop] button.

4. The [Stop a Hardware device] window will
open. Select the [USB Mass Storage
Device] and click the [OK] button.

5. A [Safe to Remove Hardware] window will
open. Click the [OK] button.

[Click!]

[Double-click!]

[Click!]

[Click!]
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Removing the removable disk

1. A USB Driver for MAC is not included with the software CD as MAC OS supports the
camera driver.

2. Check the MAC OS. You can check the MAC OS version during MAC OS start-up. This
camera is compatible with MAC OS 9.2 ~ 10.3.

3. Connect the camera to the Macintosh and turn the camera power on.
4. A new icon will be displayed on the desktop after connecting the camera to the MAC.

Using the USB Driver for MAC

Setting up the USB Driver for MAC

1. Double click a new icon on the desktop and the folder in the memory will be displayed.

2. Select an image file and copy or move it to MAC.

For Mac OS 10.0 or later : First complete uploading from computer to camera and then

remove the removable disk with the Extract command.

If a movie clip can°Øt play back on the Mac OS, please visit the following

site(http://www.divx.com/divx/mac/) and download the codec. Or, use a media player that

supports the Xvid codec (Mplayer, VLC(VideoLan Client) media player.

CAUTION

6. A [Unplug or Eject Hardware] window will open.
Click the [Close] button and the removable disk
will be removed safely.

7. Unplug the USB cable.
[Click!]
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Digimax Master
■ You can download, view, edit and save your digital image and movie clip with this software.

This software is only compatible with Windows.

■ To start the program, click [Start → Programs → Samsung → Digimax Master].

● Downloading images
1. Connect the camera to your PC.

2. A window for downloading images will display after
connecting the camera and your PC.
- To download the captured images, select the
[All(A)] button.

- Select desired folder in the window and click the
[All(A)] button. You can save captured images and
selected folder.

- If you click the [Cancel] button, downloading will be
cancelled.

3. Click [Next(N) >] button.

[Click !]

[Click !]
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Digimax Master

Before deleting images from the camera, you should download images to your
computer that you wish to keep.
Refer to the [Help] menu in Digimax viewer 2.1 for further information.

INFORMATION 

7. Downloaded images will be displayed.

4. Select a destination and make a folder to save
downloaded images and folder.
- Folders will be made in order of date and images
will be downloaded.

- Folder name will be made as you want and images
will be downloaded.

- After selecting a folder that was made before,
images will be downloaded.

5. Click [Next(N) >] button.

6. A window will open as shown alongside.
The destination of selected folder will be displayed
on the upper side of the window.
Click the [Start] button to download the images.

[Click !]

[Click !]
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Digimax Reader
● Image viewer : You can view the stored images.

- Image viewer functions are listed below.
① Menu bar : You can select menus.

File, Edit, View, Tools, Change functions, Auto download, help, etc.
② Image selection window : You can select desired image in this window.
③ Media type selection menu : You can select image viewer, image edit, movie clip edit

function in this menu.
④ Preview window : You can preview a image or a movie clip and check the multi media

information.
⑤ Zoom bar : You can change preview size.
⑥ Folder display window : You can see folder location of selected image.
⑦ Image display window : Images of selected folder are displayed.

※ Refer to the [Help] menu in Digimax Master for further information.

① ⑤
⑥

⑦

②

③

④
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Digimax Reader
● Image edit : You can edit the still image.

- Image edit functions are listed below.
① Edit menu : You can select the following menus.

[Tools] : You can resize or crop the selected image. See the [Help] menu.
[Modify] : You can modify image quality. See the [Help] menu.
[Retouch] : You can change image or insert effects on the image. See the [Help] menu.

② Drawing tools : Tools for editing an image.
③ Image display window : a selected image displays in this window.
④ Preview window : You can preview the changed image.

※ Refer to the [Help] menu in Digimax Master for further information.

①

②

③

④
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Digimax Master
● Movie edit : You can get the still image, movie clip, narration, music files together in a movie clip.

- Movie clip edit functions are listed below.
① Edit menu : You can select the following menus.

[Add] : You can add a desired multi media in a movie clip.
[Edit] : You can change the brightness, contrast, colour and saturation.
[Effect] : You can insert an effect.
[Text] : You can insert texts.
[Narration] : You can insert a narration.
[Make] : You can save the edited multi media as a new file name.

Frame display window : You can insert multi media in this window. You can select
AVI, Windows media (wmv), Windows media (asf) and movie clip for this camera
(a v I, MPEG-4) file types.

② Frame display window : You can insert multi media in this window.

※ Some movie clips that was compressed with a codec that is not compatible with the Digimax
Master can’t play back in the Digimax Master.

※ Refer to the [Help] menu in Digimax Master for further information.

①

②
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Digimax Reader
■ Digimax Reader is a Text recognition program. You can save an image file that is captured in

the Text mode, as a text file with this program.
This software is only compatible with Windows.

■ To start the program, click [Start → Programs → Digimax Reader Eng].
The following screen will appear.

■ How to use the Digimax Reader
1. Connect the camera and the PC with a USB cable and download the images that were

stored in the camera to the PC.
* Please see page 120 ~ 122 for details on Connecting a camera and PC, Downloading

images.

2. Run the Digimax Reader.

3. Click the Open(        ) icon as shown alongside.
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Digimax Reader
4. Select the image you want to save as a text file.
* Only an image that was taken with SAMSUNG

camera can be opened.

5. Click the Area Analysis(        ) icon to scan the image.

6. Part of the image you selected will be displayed as
shown.

7. Click the Character Recognition(        ) icon.
The part selected in the previous step will be
recognized as text.

8. To save the section as a text, click the Save(         )
icon. A window as shown alongside will be displayed.



139

Digimax Reader

● To get an image that can be recognized as a text : 
- Keep a distance of 20cm between the subject and the camera.
- The subject need to be centered.
- Avoid the camera shake to get a good image.

● Refer to the [Help] menu in Digimax Reader for further information.

INFORMATION 

9. Select a file type that you want to.
Selectable file type : *.TXT, *.HWP, *.DOC, *.RTF

FAQ

■ Please check the following if the USB connection malfunctions.

[Case 1] The camera power is off.
→ Turn the camera power on. We recommend using an AC power adapter in PC

mode.

[Case 2] USB Driver is not installed correctly.
→ Install the USB Driver correctly. Refer to page 110.

[Case 3] The USB cable is not connected or you are using a cable with an incorrect
specification.

→ Use a USB cable with the correct specification.

[Case 4] The camera is not recognized by your PC.
Sometimes, the camera may appear under [Unknown Devices] in Device
Manager.

→ Install the camera driver correctly.
Turn off the camera, remove the USB cable, plug in the USB cable again, and
then turn on the camera.
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FAQ
[Case 5] There is an unexpected error during file transfer

→ Turn the camera power off and on again. Transfer the file again.

[Case 6] How do I know my computer supports a USB Interface?
→ Check the USB port in your computer or keyboard.
→ Check the OS version. A USB Interface is available in Windows 98, 98SE,

2000, ME, XP.
→ Check [Universal Serial Bus controllers] in Device Manager. Do the following to

check [Universal Serial Bus controllers].
Win 98/ME : Trace [Start → Settings → Control Panel → System →

Device Manager → Universal Serial Bus controllers].
Win 2000 : Trace [Start → Settings → Control Panel → System →

Hardware → Device Manager → Universal Serial Bus
controllers].

Win XP : Trace [Start → Control Panel → Performance and
Maintenance → System → Hardware → Device Manager
→ Universal Serial Bus controllers].

There must be USB Host Controller and USB root hub under [Universal Serial
Bus controllers].
In addition, double-click on the USB Universal Host Controller and the USB
Root Hub to check if the Device Status states "This device is working properly".
If the Device Status says the device is "not working properly", click the "Driver"
tab and then click [Update Driver] or [Reinstall Driver].

→ When all the conditions mentioned above are met, the computer can support
the USB interface.

[Case 7] When using the USB hub.
→ There may be a problem in connecting the camera to the PC through the USB

hub if the PC and the hub are not compatible. Wherever possible, connect the
camera to the PC directly.

[Case 8] Are other USB cables connected to the PC?
→ The camera may malfunction when it is connected to the PC at the same time

as another USB cable. In this case, disconnect the other USB cable, and
connect only one USB cable to the camera.
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[Case 9] When I open the Device Manager (by clicking Start → (Settings) → Control Panel
→ (Performance and Maintenance) → System → (Hardware) → Device
Manager), there are  「Unknown Devices」or  「Other Devices」entries with a
yellow question mark(?) beside them or devices with an exclamation mark(!)
beside them.

→ Right-click on the entry with the question(?) or exclamation (!) mark and select
"Remove". Restart the PC and connect the camera the again. For Windows 98
PC, remove the camera driver also, restart the PC, and then reinstall the camera
driver.

→ Double-click on the entry with the question (?) or exclamation (!) mark, click the
"Driver" tab, and click [Update Driver] or [Reinstall Driver]. If a message appears
asking you to specify the location of the appropriate device driver, specify "USB
Driver" in the CD supplied.

[Case 10] In some security programs (Norton Anti Virus, V3, etc.), the computer may not
recognize the camera as a removable disk. 

→ Stop the security programs and connect the camera to the computer. Refer to the
security program instructions about how to stop the program. 

■ When the movie clip doesn’t play back on the PC

※ When the movie clip recorded by the camera doesn’t play back on the PC, the causes are
mostly due to the codec installed on the PC.

● When codec for play back the movie clip isn’t installed
→ Install the codec as listed below. 

[Installing codec for Windows]
1) Insert the CD provided with the camera 
2) Run the windows explorer and select [CD-ROM drive:\XviD] folder and click the XviD

codex-1[1].1.0.exe file. 

[Installing codec for Mac OS]
1) Visit the following site for downloading the codec.http://www.divx.com/divx/mac
2) Click the [Free Download] button located at the upper right side of the page and a window

for downloading the DivX codec will display. 
3) Select Mac OS you use and click the [Download] button. Save it on a folder you want to. 
4) Run the downloaded file and the codec for playing back the movie clip will be installed.
※ If a movie clip can’t play back on the Mac OS, use a media player that supports XviD

codec (Mplayer, VideoLanClient). 
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FAQ
● When the DirectX 9.0 or later is not installed

→ Install the DirectX 9.0 or later
1) Insert the CD provided with the camera
2) Run the windows explorer and select [CD-ROM drive:\ USB Driver\DirectX 8.1] folder and

click the DXESETUP.exe file.The DirectX will be installed. Visit the following site for
downloading the DirectX.http://www.microsoft.com/directx

● If a PC (Windows 98) stops responding while the camera and PC are connected repeatedly
→ If a PC (Windows 98) is turned on for a long time and connect the camera repeatedly, the

PC may not recognise the camera. In this case, re-start the PC. 

● If a PC connected with the camera stops responding while Windows is starting. 
→ In this case, disconnect the PC and the camera and Windows will start.

If the problem happens continuously, set the Legacy USB Support to disable and re-start
the PC. The Legacy USB Support is in the BIOS setup menu. (The BIOS setup menu
differs from the PC manufacturers and some BIOS menus don’t have Legacy USB
Support) If you can’t change the menu by yourself, contact to the PC manufacturer or
BIOS manufacturer. 

● If the movie clip can’t be deleted, removable disk can’t be extracted or an error message
displays during the file transfer.  
→ If you install only the Digimax Viewer, the problems mentioned above occasionally

happen. 
- Close the Digimax Viewer program by clicking the Digimax Viewer icon on the Taskbar.
- Install all the application programs included in the software CD. 
(You must install the Movie clip codec)



143

FAQ
If a PC (Windows 98) stops responding while the camera and PC are connected
repeatedly

If a PC (Windows 98) is turned on for a long time and connect the camera repeatedly, the
PC may not recognise the camera. In this case, re-start the PC. 

If a PC connected with the camera stops responding while the Windows is starting. 
In this case, disconnect the PC and the camera and the windows will start correctly. 
If the problem happens continuously, set the Legacy USB Support to disable and re-start
the PC. The Legacy USB Support is in the BIOS setup menu. (The BIOS setup menu
differs from the PC manufacturers and some BIOS menus don’t have Legacy USB
Support) If you can’t change the menu by yourself, contact to the PC manufacturer or
BIOS manufacturer. 

If the movie clip can’t be deleted, removable disk can’t be extracted or an error
message displays during the file transfer.  

If you install only the Digimax Viewer, the problems mentioned above occasionally
happen. 
- Close the Digimax Viewer program by clicking the Digimax Viewer icon on the Taskbar.
- Install all the application programs included in the software CD. (You must install the
Movie clip codec)
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